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LIMITED WARRANTY

7~ This is 2 “Limited Warranty” as defined in the Consumer Product

Warranty and Federal Trade Commission Improvement Acts. This
Warranty gives you specific legal rights, and you may also have other
rights that vary from state to state.

Your Electronic Products, made or imported by NAVARONE INDUS-
TRIES, are warranted to be free of defects in materials and work-
manship under normal use. NAVARONE INDUSTRIES’ obligation under
this Warranty shall be limited to repair or replacement (at our option)
at our premises, of any defective part when the product is shipped
to NAVARONE INDUSTRIES within 90 Days following the date of origi-
nal purchase.

Under no circumstances will NAVARONE INDUSTRIES be liable for
incidental or consequential damages or for any expenses incurred
by reason of the use or sale of any such Electronic Product.

This Warranty is expressly in lieu of all other warranties, expressed
or implied, including the implied warranty of merchantability, and
nothing any person says can increase NAVARONE INDUSTRIES’ lia-
bility beyond that stated here.

This Warranty is limited to the original purchaser from 2 NAVARONE
INDUSTRIES dealer. The unit presented for service under this War-
ranty must be accompanied by a purchase receipt which indicates
the date of purchase, or the warranty registration card must have
been filed with NAVARONE INDUSTRIES within 14 days of purchase.
It is the responsibility of the customer to carefully pack the prod-
uct and ship it prepaid and insured to NAVARONE INDUSTRIES.

NAVARONE INDUSTRIES, INC.
21109 LONGEWAY RD.  SUITE C

SONORA, CA 95370

(209) 533-8349

TLX: WWI 650-230-9046




Electronics in the ST Scan interface designed by
Alex Stangle

Software designed and written by
Mike Curry

ST SCAN is a trademark of Navarone Industries, Inc.

CANNON IX-12 is a registered trademark of Cannon Corp.

Atari is a registered trademark of Atari Corp.

Atari ST and TOS are trademarks of Atari Corp.

GEM is a trademark of Digital Research Inc.

Postscriptis a registered trademark of Adobe Inc.

Publishing Partner is a registered trademark of SoftLogik Corp.

QMS and PS-800 are registered trademarks of Quality Micro Systems.
DEGAS is aregistered trademark of Bateries Included.

LaserWriter is a registered trademark of Apple Computer Inc.

ST SCAN manual and software copyright 1986 Navarone Industries Inc. All
Rights Reserved.
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INTRODUCTION

ST SCAN is the most powerful input device available for the
Atari ST computer. ST SCAN is used with the Canon IX-12™
high resolution image digitizer to input photographs, artwork or
technical drawing into your computer. You can then edit, paint,
cut and paste it, and reproduce the sharpest image your laser
printer can handle. ST Scan software makes it very easy to use
with simple drop down menu comands.

You can use ST SCAN to digitize images in special halftone
mode for photographs, or line art mode for drawings, Logos or
any high contrast image. You can choose the resolution from 75
dots per inch (DPI) up to 300 DPI. The ST SCAN software
allows you to scan selected areas from a sheet thereby
enabling only the desired part of the page to be scanned.

A WORD OF CAUTION: Scanning images at high resolution
can consume tremendous amounts of memory. The software
automatically limits the size of the scan area according to the
memory available on your computer.

You may choose to save your scanned images in several file
formats. ST SCAN will not print the image to a printer.
The only way to printout your scanned image is to use a
program that supports your printer to print the image file.

The format you choose to save your image will also be used to
determine the size of scan area allowed. If you choose the
DEGAS" file format then you will be limited to an area which will
be no larger than a screen display. You can increase the scan
area by selecting a lower resolution number. This is because the
number of dots which make up your scanned image will
determine how large of area can be shown and edited using the
DEGAS" program. Other art and graphic editing programs are




being written to allow editing scanned images at higher
resolutions. Such a program will soon be available from
Navarone called ST LASERPAINT".

HOW TO USE THIS MANUAL

ST SCAN is very easy to use. If you read the section on USING
ST SCAN, you will probably have no trouble using the ST
SCAN system. The HELP function will most likely provide all
the assistance you need.

So, if you are eager to start, go right on to WHAT YOU WILL
NEED. Read USING ST SCAN, and have fun!

WHAT YOU WILL NEED

1. An Atari ST computer with a minimum of 512K of RAM.
2. A Monochrome or Color monitor.

3. At least one floppy disk drive.

4. The ST SCAN Program disk.

5. The ST SCAN Interface unit and cable.

6. The Cannon IX-12 image scanner.

7. A formatted work disk for saving scanned images.

STARTING THE SYSTEM

Before applying power to the computer system, make sure that
all cable and power connections are inserted properly. If you do
not have the TOS operating system in ROM, you will need to
insert a disk containing TOS into the disk drive. Turn on your
monitor, your disk drive and then your computer. When the
computer has finished loading information into its memory, the
GEM Desktop will appear on the monitor screen.




MAKING A BACKUP COPY

Before using the ST Scan program, you should make a backup
copy of your original ST SCAN floppy disk. (You can buy extra
disks at most computer retail stores). Use the backup disk and
store the original away in a safe place. Then, if anything
happens to the backup while you're using it, you can just make
another copy from the original. With the computer turned on,
follow these steps and read the prompts that appear in the
Dialog Boxes.

1. There is a small plastic write-protect tab on most floppy disks
which can be moved to either of two positions. A disk is
write-protected when the tab is placed to leave the write-protect
notch open (you can see through it). While the tab is in this
position, the disk cannot be formatted, erased, or written to.
Sliding the tab to the closed position allows information to be
recorded on the disk, the original disk should be write-protected
(with the notch open) and the blank backup disk should have
the notch closed.

2. If you have one disk drive, insert the blank backup disk into

the disk drive and place the original ST Scan disk aside. When
the ST Computer requires a disk change, it will display the
message in a Dialog Box. NOTE: If you have two disk drives,
insert the original ST Scan disk into Drive A and the backup
disk into Drive B. With two drives, always keep the original disk
in Drive A, the backup disk in Drive B, and follow the prompts.

3. To format the backup disk, click on the icon for Floppy Disk
B and select the Format option from the File menu. The first
Format Box will appear, giving the options OK and Cancel.
Click on the OK button. The second Format Box will appear.




Make sure the option "Single- sided" is shaded, then click on
the Format button. If you have one drive, Disk B (the Backup
disk) is already in Drive A, so continue on.

When the disk is finally formatted, a message will appear
showing the amount of information which it can hold. Click on
the OK button, and you will be returned to the Format Box.
Then click on the Exit button.

4. To copy the original ST Scan disk to the backup disk, insert
the original disk into Drive A, select Floppy Disk A with the
mouse pointer, drag it on top of the Floppy Disk B icon, and
release the mouse button. A dialog box will appear with the
options OK and Cancel. Click on the OK button. The Diskcopy
Box will appear. Click on the Copy button and follow the
prompts to complete the copying process. When the disk has
been copied, the Diskcopy Box will appear again. Click on the
Exit button.

5. Use this backup disk and store the original away in a safe
place. Then, if anything happens to the backup while you're
using it, you can just make another copy from the original.




USING ST SCAN

LOADING THE PROGRAM

First, start your computer system by following the directions
given above under "Starting the System". If you're using a
color monitor, select Set Preferences from the Options menu,
make sure the Medium Resolution option is shaded, and click
on the OK button.

Insert the backup ST Scan disk into Drive A. Move the mouse
cursor over the icon for Floppy Disk A and click the mouse
button two times in rapid succession. The disk icon should
open into a window which contains an icon for each file on the
disk. To enter the ST Scan program, double-click (click twice
rapidly) on the icon or filename STSCAN.PRG. The ST Scan
program is not copy protected.

WARNING: Don not insert paper into scanner until after
you have loaded the ST SCAN Program.

SETTING UP
To setup the ST SCAN image scanner and program.

1. Turn your computer and the Cannon IX-12 OFF.

2. Plug the ST SCAN Interface unit into the cartridge port on
the left hand side of the Atari ST Computer.

3. Connect the cable from the Cannon IX-12 image scanner
to the ST SCAN interface unit.

4. Insert your working copy of ST SCAN program disk into
your disk drive and turn on the computer and the Cannon
IX-12 scanner. DO NOT INSERT PAGE INTO
SCANNER UNTIL REQUESTED BY PROGRAM.

5. Run the program STSCAN.PRG.

(o]



STARTING UP

The program will display the title screen shown below. You
must click on "OK" in the dialog box before continuing.

ST SCAN Version 1.8

COPVRIGHT €C) 1987 ~- ALL RIGHTS RESERVED

: Navarone Industries, Inc.
Notice the number of Kbytes 21109 Longeway Road, Suite €
is displayed to show how Sonora, CR 95378
much room is available for (xom nas-nses

your image buffer.

OESIGNED AND WRITTEN BY

DROP DOWN MENUS

All commands are initiated from the drop down menus as
shown here. If this is the first time you are using the ST SCAN
program then please read the lasted updates and revisions by
clicking on the box as shown below.

ile Scan View Options [[TITR
ST SCAN V1.0 (| MWelcome... stries !

e a0 a0 e s s e s 200 00 00 200 0 00 200 D0 200 P a0 00

Fl le LN ]
- - - Scan...
The What's new file contains the lates;l

; . . View
information and corrections to th U;: Lons. ..
manual.

v oo e 000 ot a0 000 oot o0 ooe o000t oot 000 000 o0 o0 000 Pt 000 000

SuEEort...




OPTIONS

The options menu has two items, Scanner and Format. select
the FORMAT option and click on it with the left mouse button.

Desk File Scan View JITITIIA Help

Scanner... Navarc

B oeces
] M6

] Postscript

FORMAT

The format option allows you to select the type of file format in
which to save the scanned image . Presently three formats are
used. DEGAS (normal), .IMG (Gem standard), and
POSTSCRIPT.

10



DEGAS" Format

is used if you wish to save the image in a file which can be
loaded into the DEGAS™ or DEGAS ELITE™ program. This
format is popular of your image is to be edited with graphic
programs capable of reading DEGAS" files. It also limits the
size of the scanned image area to only that which can be shown
on the monitor dnsplay If greater resolution is required use the
POSTSCRIPT" or .IMG format. A DEGAS format will be saved
with the current screen resolution.

IMG Format

Use the .IMG format when saving images for use with the
following programs. PUBLISHING PARTNER, ST
LASERPAINT™ and EASY DRAW™ with SUPERCHARGER" .
This format is useful for saving images that are to retain thelr
original scanned resolution.

Postscript™

The postscript™ format is used when the file is to be printed on
a postscript device like a LASERWRITER™ or QMS PS-800"
laser printer.

When a Postscript™ or .IMG format is selected, the program will
allow you to set up the scan area window according to available
memory. If the DEGAS™ fomat is selected, the scan window is
pre-defined according to the resolution you select. A resolution
of 75 dpi will allow a larger scan area than the 300 dpi setting.
This is because the display on the monitor is limited to 72 dots
per inch and as the number of dots per inch increase, the larger
the screen must be to display the image. Since the screen is a
fixed size we can only adjust the size of the scan area to
compensate for the change of resolution.

1



Programs like ST LASERPAINT™ will allow large scan areas to
be edited and saved in .IMG files with the same resolution.
Programs using the .IMG format can display the image in lower
resolutions while retaining the high density for outputing to laser
printers. The real power of scanned images are best
demonstated when printing on laser printers.To select a format
simply click on the box next to the desired format then click on
the OK box to activate.

SCANNER OPTIONS

Set up the resolution, mode and density from this menu. Use
the halftone option when scanning photographs. Use
Monochrome is scanning line art. The resolution you select will
affect the size of scanned image.

SCANNER RESOLUTION - DOTS PER INCH

150 ] [zeo] (380]

CONTRAST BCANNING METHOD:

D L1GHT
. NORMAL

D HALFTONE
D DARK

LINE ART
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SCANNING THE IMAGE

Place the image to be scanned into the Cannon IX-12™ face
down. Be sure the page is positioned as far forward as it will go.
The Cannon IX-12 ™ should "grab" the page and start it feeding
afewinches, then stop. At this time, select the SCAN menu.

37 Navarone Industries Eﬂ

Load Page into Scanner.
Click OK to proceed, or CANCEL to abort. 4

There are two selections on the SCAN menu. FULL PAGE and
WINDOW. The FULL PAGE option is used as a kind of
pre-scan. You can use the pre-scan (FULL PAGE) to give a
position display that can be used to locate the window scan

area. You do not have to use a pre-scan but it is helpful in lot of
cases.

To use the pre-scan option, select the FULL PAGE from the
scan menu. The display above should appear.

When you have loaded the page into the scanner click on the
OK button to start the scan. Once the image is scanned (about
12 seconds), the entire page is displayed on the screen.
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The screen should now contain a condenced image of the
entire page that was scanned. This first pass was just to show
the full page so you can position the window over only the
section you wish to scan.

SELECTING SCAN WINDOW

Place the window over the area you wish to scan. If you are
using the .IMG or Postscript™ formats ( see options), you can
also adjust the shape of the window. To adjust the window
shape simply place the mouse pointer inside the square handle
attached to the right bottom corner of window. Hold down the
left mouse button while dragging the window to it's desired
shape. The program will automatically "drop" the window if you
exceed the available memory for the size of window you are

shaping.

Now select the window selection from the scan menu. Again the
dialog box from the previous page appears. Load the paper and
click on the OK button to start the final scan.

VIEW MENU

This allows you to view the full page (first scan), or the window
which was scanned under "Window Scan" option. You can use
the window view to see the results of the final scan before
saving to disk.

FILE MENU

Scan View Options Help
Save as... |V1.8 Cc) 1987 ¢

Delete File...
Format Disk...
Free Space...
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Free space

Selecting this option allows you to display the free space
remaining on your disk. The following dialog box will appear.

You can select any drive from the above display. Click on the
appropriate button and click OK to display the free space on
that disk as shown here. Then click on OK to return.

Drive D

Available: 8271872 8078
Used: 2330624 2276
Total: 10602496 18354
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FORMAT DISK
Select the Format disk option from the File menu panel. The
following dialog box will be displayed.

Lorat bisk

 Drive [N TIUENN

. SINGLE SIDED
D DOUBLE SIDED

Select the appropriate drive by clicking on the drive box. Select
single or double sided, then click on OK when ready.

NOTICE: Formatting a disk will erase the entire contents of the
disk. Be very certain you have the correct disk inserted in the
selected drive prior to clicking on the OK button.

This format command cannot be used to format a hard disk. To
format the hard disk you must use a special format program
provided with your hard disk.
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DELETE FILE

This option is provided to allow you to delete a file from your
disk if you need to make room to save the current scanned

image.

When you select this option the following display prompting you
to select the file you wish to delete. This works like most GEM
programs. That is, you enter the name of the file to delete, click
on the OK button and the file will be deleted.

ITEM SELECTOR

Directory!
C:\DEGAS\FILLS\¥,*

CRACKER .FIL
DIAGONAL.FIL
SMILES .FI2
SMILEY .FIL

ﬁelection:
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USING SCANNED IMAGES

Once you have scanned an image into the computer it may be
used by other application programs or printed out directly on a
Postscript printer such as the QMS PS-800 or Apple
LaserWriter printers. If you wish to print on other printers you
must use a program that supports the printer an import the
scanned image into that program.

Editing scanned images

Until now, most graphic editors and drawing programs operate
on screen sized images. Now that you can scan images that are
larger than a single screen size you will need a way to edit those
images. We have provided a simple chegp and dirty way to use
existing graphic products by breaking down a large image into
several screen sized pictures. Once you have edited the image
segments you can re-assemble these files into a single large
image file suitable for importing or printing.

To convert a large image file it must first be stored as a .IMG
file. The conversion program is supplied on the ST SCAN
Distribution disk. Run the conversion program to segment the
.IMG file into several DEGAS files. You will notice the
conversion program any relolution to be used as the output file.
Once you have segmented the .IMG file you can use the
DEGAS ELITE program to edit any or all image segments.

After you edit the segments, run the conversion program to
reverse the process and combine the multiple screen files back
into the single (.IMG ) file.
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Printing images on Laserwriter
To print a scanned image you must first save the image in the
POSTSCRIPT format. (see section on File Formats).

Once an image is saved in the Postscript format it can be
printed directly on any postscript printer or high resolution
Linotronic 100 or 300 typesetters.

Prior to printing with GEM desktop you must make sure your
printer is installed and the proper port is selected. To set up
your printer port you must use the CONTROL Panel
(CONTROL.ACC) program provided with your computer.
Please refer to the manual provided with the Computer for
information in setting up the RS232 configuration and
Installing the printer.

Exit the ST SCAN program by selecting the QUIT option under
the FILE menu.

With the Desktop file directory displayed, double click on the
postscript file you saved your image into earlier. A dialog box
will instruct you to either show, print or cancel. Click on PRINT.

The image will be sent to the printer and printed in the same
location on the page as it was originally scanned from the
source page.
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SUPPORT POLICY

To receive support services from Navarone Industries, Inc.,
please fill out and return the enclosed registration card.
Customer support is provided either through postal
correspondence or by telephone.

Warranty: Navarone Industries, Inc. warrants that the Navarone product and
program diskette is free from defects in material and workmanship, assuming
normal use, for a period of ninety (90) days from the date of purchase. If a
defect occurs during this period, please return your product to Navarone
Industries, Inc., along with a dated proof of purchase, for repair or a
replacement free of charge. Navarone Updates: Navarone Industries, Inc. will
occasionally make revisions and updates to this publication and to the
accompanying program. Contact us for further information on program
updates. Navarone Industries, Inc., reserves the right to make changes to
this publication, and to the Navarone program, without obligation to notify any
person of such changes.

NOTICE: EXCEPT FOR THE EXPRESS WARRANTY SET FORTH
ABOVE, NAVARONE INDUSTRIES, INC., GRANTS NO OTHER
WARRANTIES EXPRESSED OR IMPLIED, BY STATUTE OR
OTHERWISE, REGARDING THE DISK AND RELATED MATERIALS,
THEIR FITNESS FOR ANY PURPOSE, THEIR QUALITY, OR THEIR
MERCHANTABILITY.

THE LIABILITY OF NAVARONE INDUSTRIES, INC., UNDER WARRANTY
SET FORTH ABOVE SHALL BE LIMITED TO THE AMOUNT PAID BY THE
CUSTOMER FOR THE PRODUCT. IN NO EVENT SHALL NAVARONE
INDUSTRIES, INC., BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL,
OR OTHER DAMAGES FOR BREACH OF WARRANTY.

All Rights Reserved: No part of this publication may be reproduced,
transmitted, transcribed, stored on a retrieval system or translated into any
language, in any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual or otherwise, without the prior written consent of
Navarone Industries, Inc. The program(s) contained in this package are
licensed for use by the owner on a single machine.
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